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1. ISP Programming Conn: A socket for the ISP Programmer, which allows easy insertion/removal of the in-system
programmer.
2. Power I/P (Power Input): This is the power supply input to the board, providing necessary +5V voltage from the
USB Type-C connector to power the board when the programmer is not connected.
3. 8051 MCU:Any 8051-based 40-pin DIP IC can be used with this board. This board is equipped with AT89S52.
4. UDB Conn:These connectors are used to attach this kit to the Universal Development Board (UDB) by Amotech
Labs. Check UDB details on our website.
5. Digital 2 I/P Button Switches:Two push buttons serve as digital input switches connected to P1.2 and P1.3. When
configured as inputs, they are pulled up at logic HIGH. On pressing, they are connected to ground, making the pin state
LOW.
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8. 16x2 LCD

7. 10K LCD 
Contrast
Pot.

4. Reset Sw 

5. MCU Ports

6. UDB Conn.

3.USB C
Power Conn.

1. Any8051basedMCU
( 89S52 IC) 

2.ISP Programmer Connector

14. +5V & GND Conn. 

13.ADC0804 IC Slot 

12.Analog I/P Vtg. 
Source Conn.

11.Vref. Vtg. Pot. 
Conn.

10. 7 Segment Display.
 with GND Jumper

9. 4x4 Keypad

ISP Programmer

Most of the above labels are self-explanatory. Below is the description needed for some of the labels. Also check the
brief Introduction of 8051 (AT89S52) and Schematic of the Kit in the following pages for detailed understanding.
1. Microcontroller (AT89S52): This kit comes with AT89S52 IC, but it can support any 8051-based 40-pin DIP IC.
2. ISP Programmer Connector: It is used to connect a USB ISP Programmer for programming the microcontroller.
3. USB-C Power Connector: It is a USB Type-C connector. This board can be powered using a +5V USB-C adapter.
4. UDB Conn: These connectors are used to attach this kit to the Universal Development Board (UDB) by Amotech
Labs. Check UDB details on our website.
5. 4×4 Keypad: The 4×4 keypad is connected to Port 2 of the 8051 microcontroller.
6. 7-Segment Display: It is optionally connected to Port 0 of the MCU. Port 0 values are reflected on the display
when its jumper is inserted. The jumper connects the common cathode of the 7-segment display to ground.
7. Vref Vtg. Pot.: This connector can be used to insert a 10 kΩ potentiometer to adjust the reference (Vref) voltage
for ADC0804. When this potentiometer is not inserted, the default Vref is 5 V, provided no external Vref is applied.
8. Analog I/P Vtg. Pot.:This connector allows insertion of a 10 kΩ potentiometer or LM35 sensor to provide a
variable analog input voltage to ADC0804.
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 ‘8051 Development Board’ can be mounted on below UDB Kit:



AMOTECH
LABS 

AMOTECH LABS
 Sharing Enthusiasm for Embedded Systems & Automation.

8 
www.amotechlabs.com

 
+91-8329537565 

 
amotechlabs@gmail.com

Note: This Kit was assembled for College Lab use in Wooden Box Enclosure. That’s why it is fitted on

 
a Acrylic Sheet with Motors mounted on it for studying their interfacing using 8051 MCU & UDB.
 For Students, only UDB is also available to buy with ‘UDB 2 Wheel Robot Acrylic Sheet’.
Students can configure the UDB by adding the peripherals as per their application needs. 

Embedded/IoT Development | Automation Services | Training & Counselling
 Embedded Development Boards/Kits |PLC &Automation Training Stations.

 ‘8051 Development Board’ mounted on UDB Kit’s Slot 1 can be seen in the below
 UDB Kit which has DC, Servo and Stepper Motors mounted on-board. 



 Introduction to AT89S52 Microcontroller

Operating Frequency: DC to 33 MHz
Program Memory Size: 8 KB Flash
Program Memory (Instructions): 8192 instructions
Data Memory (Internal RAM): 256 bytes
Data EEPROM Memory: Not available
Interrupt Sources: 6
I/O Ports: 4 ports (Port 0, Port 1, Port 2, Port 3), total 32 I/O lines
Timers/Counters: 3 timers, 16-bit each (Timer 0, Timer 1, Timer 2)
Capture/Compare/PWM Modules: Not available
Enhanced Capture/Compare/PWM Modules: Not available
Serial Communication Interface: UART
Universal Serial Bus (USB): Not available
Streaming Parallel Port (SPP): Not available
Analog Comparators: Not available
Programmable Low-Voltage Detect: Not available
Instruction Set Size: 255 instructions
Supported Packages: 40-pin DIP, 44-pin PLCC, 44-pin TQFP

Features of AT89S52: 
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Keil IDE for Programming of 8051 (AT98S52) MC

Below are the steps to program any AT89S52 code
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1.Select New µVision Project from the Project Menu.

2. Create New Project” window will pop up, type a project name and location for the project and save.
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3.Select Device for Target” window will pop up, select your device (here we selecting AT89S52)

4.“µVision” window will ask for copy STARTUP.A51 to the project folder and add a file to the project 
(If necessary you can select “No” but we recommended you to select “Yes” because it will help to run the 

program smoothly. )
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6.Save program code with “.c“ extension (In case if you are using assembly language then save
 

5.Now select New file from the File menu and type your program code (here we have typed LED
blinkingprogram)
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7 .Right-click on Source Group 1 folder from Target 1 and select “Add existing files to Group 
‘Source Group 1’”

8.Select the program file saved with “.c “or “.asm” (in case of assembly language) and add it. Then 
close that window. You can see the added file in the “Source Group 1” folder in the left project window.
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10.To create a Hex file right click on Target 1 and select Option for Target ‘Tar

9..Now select the Project menu and click on “Build target”, it will build a project and give status in 
the Buildoutput window with Error and Warning count if any.
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11.The target window will pop up, enter Xtal (MHz) frequency (here we used 11.0592 MHz), and tick
 mark in front of the “Use On-chip ROM” tag.

12. Within the same window select the “Output” option and tick mark in front of the “Create Hex File” tag
and click on OK.
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13 .Now again select build target from the Project menu or simply hit the F7 shortcut key for the same, 
it will build target and also create a Hex file. You can see creating a Hex file in the Build output window

14.Check Video Tutorials on our YouTube Channel, for Instructions of Installing ISP Programmer 
Drivers, Compiling the program and Downloading the Hex File into our 8051 Development Boards. In Videos
for ‘8051 Development Boards’, under their description you will also find a Google Drive Link to download
ISP Programmer, Drivers, Programmer Software Files, Sample Programs and Schematic. 

YouTube Channel : https://www.youtube.com/@AmotechLabs



Lab 1 - LED Blinking 

 Aim: 

Procedure:
1.Read the LED Blink Program on the next page with all the comments explaining the code. 
2.Open the Project folder in Keil µVision IDE or create a new project following the Keil manual. 
3.Build the project and generate the HEX file. 
4. Use a USB ISP programmer along with ProgISP software to download the Hex file into your 8051 based
89S52 Microcontroller.
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To study the LED’s Interfacing with AT89S52 and blink them in different patterns with delay.
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Program



 Aim: 

Procedure:
1.Read the SSD Counter Program with comments explaining the code. 
2.Open the Project folder in Keil µVision IDE or create a new project following the Keil manual. 
3.Build the project and generate the HEX file.Use a USB ISP programmer along with ProgISP software to
download the Hex file into your 8051 based 89S52 Microcontroller.
4.Insert the SSD Ground jumper to provide ground to both SSDs. 
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To study the Interfacing SSD(Seven Seg. Displays) with AT89S52 by doing SSD Counter
Program. 
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Lab 2 - SSD Counter 



Program:
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Aim: 
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To study the 16x2 LCD Interfacing with AT89S52.

.Procedure: 1.Read the LCD Interfacing Program with all comments explaining the code. 
2.Open Keil µVision, create/open a project for 8051 (AT89C51), write the program, and build it to generate
the Hex file.
3.Use a USB ISP programmer along with ProgISP software to download the Hex file into your 8051 based
89S52 Microcontroller. 
4.Adjust the LCD contrast using the 10k pot. Once programmed and disconnected, the expected content will
appear on the LCD. 
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Lab 3 - LCD Interfacing 
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Program:
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Aim : 
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To study the Interfacing of 4x4 Keypad with AT89S52.

1.Read the Keypad Interfacing Program on the next page with all the comments explaining the program. 
2.Open the Project folder for the program in Keil µVision IDE or create a new project following the procedure
explained in the Keil manual. Build the project and generate the HEX file.  
3.Use a USB ISP programmer along with ProgISP software to download the Hex file into your 8051 based 89S52
Microcontroller.
4.If you entered the correct passkey then you will get acess otherwise you will get the message “Access denied”.  
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Procedure:

Lab 4 - 4x4 Keypad Interfacing 
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Program:
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To study the ADC Interfacing with AT895S2

1.Read the ADC Interfacing Program on the next page with all the comments explaining the 
program 

2.Open the Project folder for the program in Keil µVision IDE or create a new project following 
the procedure explained in the Keil manual. Build the project and generate the HEX file. 

3.Use a USB ISP programmer along with ProgISP software to download the Hex file into your 8051 based 89S52 
Microcontroller. 

4.Make sure that, a Analog input is given to ADC0804 by using 10k pot or a LM35 sensor which is inserted into
the Analog Input slot.

 Aim:

Procedure:
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Lab 5 - ADC 0804 Interfacing 

0804 IC Slot.
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 Aim:

Procedure:
1.Read the ADC Interfacing Program on the next page with all the comments explaining the
program 
2.Open the Project folder for the program in Keil µVision IDE or create a new project following
the procedure explained in the Keil manual. Build the project and generate the HEX file. 
3.Use a USB ISP programmer along with ProgISP software to download the Hex file into your
8051 based 89S52 Microcontroller. 
4.The Microcontroller and external ADC0809 should be connected using connector wires as seen
in above pic.
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Lab 6 - ADC 0809 Interfacing 

To study the ADC 0809 Interfacing with AT895S2
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ADC 0809
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Procedure for User-Defined Timer (AT89S52)
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Lab 7. Timer 

Aim: To study the Timer operation of the AT89S52 microcontroller by configuring and using its internal timer to
generate accurate time delays.

Study the user-defined timer program and understand the timer configuration and delay calculations given in
the comments. 
Open Keil µVision IDE and create a new project or open the existing project for the timer program. 
Select the appropriate device (AT89S52) and add the source file to the project. 
Configure the required timer mode (Timer 0 / Timer 1) in the program and load the calculated initial count
values. Build the project and generate the HEX file. Use a USB ISP programmer along with ProgISP software
to download the Hex file into your 8051 based 89S52 Microcontroller. 
Power ON the kit and observe the timer operation (LED blinking / LCD display / output pin toggling). 
Change the user-defined delay value in the program and repeat the experiment to verify timer accuracy.
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Program
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Note: Same code can be executed on ‘8051 Mini-development board.’
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Lab 8: Serial Communication

Aim: To study and implement USB to TTL serial communication between a PC and the AT89S52 (8051)
microcontroller for bidirectional data transfer.

Procedure
Study the USB to TTL serial communication program and understand UART initialization, baud rate
setting, and data transmission/reception explained in the comments.
Open Keil µVision IDE and create a new project or open the existing serial communication project.
Select the AT89S52 microcontroller and add the source file to the project.
Build the project and generate the HEX file without errors.
Use a USB ISP programmer along with ProgISP software to download the Hex file into your 8051 based
89S52 Microcontroller.
Connect the USB to TTL converter to the microcontroller UART pins (TXD and RXD) and connect the
USB end to the PC.
Open PuTTY serial terminal software (download link:
https://apps.microsoft.com/detail/XPFNZKSKLBP7RJ?hl=en-IN&gl=IN&ocid=pdpshare) and configure
the COM port and baud rate.
Send data from the PC and observe the received data on LCD or terminal; verify data sent from the
microcontroller is received correctly on the PC.
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PuTTY configuration

USB to TTL  Modules for Serial communication

P3.0_RXD
P3.1_TXD
GND
+5V 

Click Here 
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PuTTY Serial monitor to receive data transmitted by the 8051 
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PuTTY configuration for serial communication
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Program
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Lab 9: GSM Module (SIM900A) Interfacing

Procedure:
Study the GSM interfacing program to understand UART initialization, baud rate setting (9600 bps), and AT
command operation.
Create or open the project in Keil µVision, select the AT89S52 microcontroller, add the GSM source file, build
the project, and generate the HEX file.
Program the AT89S52 using a USB ISP programmer and ProgISP software.
Connect the GSM module, LCD (4-bit mode), PIR sensor, and LED to the 8051 microcontroller as per the given
pin configuration.
Power the GSM module and initialize it in TEXT mode using AT commands, then continuously monitor UART
data.
Receive SMS commands (ON/OFF) to control the LED and send alert SMS when motion is detected, while
displaying the status on the LCD.

Aim:To study and implement GSM-based wireless communication using the AT89S52 (8051) microcontroller to
receive SMS commands and control external devices, enabling remote monitoring and control.
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 Program in c to send SMS from the GSM module.
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Program in C to receive SMS from the GSM module                           
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Lab 10: Relay Interfacing 

Aim: To interface a relay with the 8051 microcontroller and control its ON and OFF operation.

Procedure:
Study the relay interfacing program to understand digital output control of the relay using Port P2.0 and
software delay generation.
Create or open the project in Keil µVision, select the AT89S52 microcontroller, add the relay interfacing
source file, build the project, and generate the HEX file.
Program the AT89S52 microcontroller using a USB ISP programmer and ProgISP software.
Connect a 12 V active-LOW relay module to Port P2.0 of the 8051 through a proper relay driver circuit;
alternatively, a 5 V relay module with optocoupler isolation can also be used.
Power ON the system and observe the relay turning ON when logic LOW is applied and OFF when logic
HIGH is applied at regular time intervals.
Verify relay operation by connecting an external load and confirming correct switching behavior.

Relay Coil voltage 
+12v/+5v 

(from external power supply)
+5v GND Input from P2.0

( From 8051 Development Board )
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Program
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Lab 11: Servo Motor Control Using PWM

Aim: To control the position of a servo motor using PWM generated by the AT89S52 (8051)
microcontroller and operate it through a keypad interface, with status and menu display on a 16×2 LCD.

Procedure
Study the principle of PWM generation using Timer-0 interrupt of the AT89S52 microcontroller for
servo motor control.
Create a new project in Keil µVision, select the AT89S52, write the embedded C program, and generate
the HEX file.
Program the AT89S52 microcontroller using a USB ISP programmer and ProgISP software.
Interface the servo motor to Port P1.0, 4×4 keypad to Port-2, and 16×2 LCD in 4-bit mode to Port-3 as
per the circuit diagram.
Power ON the system using an external 5 V supply for the servo motor and observe the LCD displaying
the project title and menu options.
Press the keypad keys to control the servo motor at 0°, -90°, +90°, and sweep mode, and verify smooth
and stable operation.

P1.0

Servo Motor used
inside

TOWER PRO 
SG90
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Lab 12: DC Motor Control Using PWM

Aim: To control the speed and direction of a DC motor using PWM generated by the AT89S52 microcontroller
and display the motor status on a 16×2 LCD.

Procedure:
Study the principle of DC motor operation and PWM generation using Timer-0 interrupt of the AT89S52
microcontroller for speed control.
Create a new project in Keil µVision, select the AT89S52, write the embedded C program for DC motor
speed and direction control using PWM, and generate the HEX file.
Program the AT89S52 microcontroller using a USB ISP programmer and ProgISP software.
Interface the DC motor to the microcontroller through a motor driver circuit, connect the PWM enable pin
to Port P2.0, motor direction control pins to Port P1.6 and P1.7, push-button switches to Port-0, and the
16×2 LCD in 4-bit mode to Port-3 as per the circuit diagram.
Power ON the system using an external DC supply for the motor and verify that the LCD displays the
motor speed (in %) and direction (CW/CCW).
Press the increase and decrease switches to vary the motor speed in steps using PWM, press the direction
switch to change the direction of rotation, and press the stop switch to stop the motor.
Observe and verify smooth speed variation, proper direction change, and stable operation of the DC motor
for all switch operations.

BO DC Motor
(5V) 

L293D Motor Driver
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Lab 13: Interfacing of Stepper Motor

Aim: To control the speed and direction of a stepper motor using the AT89S52 microcontroller by generating precise step
sequences with Timer-0–based delays.

Procedure:
Study the principle of stepper motor operation, including full-step and half-step excitation methods, and
understand how precise delays control speed and direction using Timer-0 of the AT89S52 microcontroller.
Create a new project in Keil µVision, select the AT89S52 device, write the embedded C program to generate
stepper motor drive sequences (half-step and full-step) with Timer-0–based delay, and compile the program to
generate the HEX file.
Program the AT89S52 microcontroller with the generated HEX file using a USB ISP programmer and ProgISP
software.
Interface the stepper motor to the microcontroller through a ULN2003 driver circuit , connect the stepper motor
phases to Port P2, and ensure proper power supply connections for both logic and motor.
Power ON the system and verify that the stepper motor rotates clockwise using half-step sequence and
anticlockwise using full-step sequence as defined in the program.
Vary the delay value in the program to change the speed of rotation, observe accurate step movement, correct
direction control, and stable operation of the stepper motor for both stepping modes.

Stepper Motor used:
28BYJ-48 (5V DC)

Stepper Motor Driver used:
ULN2003
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